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GWTreecast 

Getting Started 

Thank you for Purchasing GWTreecast 
Thank you for entrusting Messaging Architects with the care of your internet mail management solution. At 
Messaging Architects, we pride ourselves in the high quality of our software solutions and the devotion with 
which our customer service will address all your concerns and needs. This guide is meant to assist you in the 
daily tasks of administering the features of your GWTreecast Server. Do not hesitate to refer to this guide often, 
as it contains helpful tips and tricks for the administration, configuration, and operation of your GWTreecast 
Server. If this guide is outdated, please contact Messaging Architects and we will provide you with the latest 
electronic version or download it from www.messagingarchitects.com/GWTreecast

About GWTreecast 
GWTreecast is a Shared Folders management solution for GroupWise, integrated with eDirectory. It allows 
building of Shared Folders trees, without end users intervention. GWTreecast supports broadcast of entire trees 
to users’ accounts, maintaining the folder’s hierarchy. GWTreecast is also capable to rebuild the trees in the end 
users accounts in case of accidental deletion, move or renaming of folders. 

Intended Audience 
This guide is intended for the GroupWise Administrator. It explains how to install, configure, operate, and 
maintain GWTreecast. This guide assumes the user is knowledgeable about common GroupWise and NetWare 
terms, concepts, and techniques. 

Technical Support & Feedback 
If you have a technical support question, please consult the Technical Support section of our website at 
www.messagingarchitects.com/support or call 1-866-497-0202 (US & Canada) or +1-514-392-1303, and a 
member of our technical support team will contact you as soon as possible during regular business hours. If you 
have a general feature question or comment, you may submit it at www.messagingarchitects.com/contactus. 

Sales 
To contact a Messaging Architects sales team member, send an email to info@messagingarchitects.com, call  
1-866-497-0101, or complete the form at www.messagingarchitects.com/contactus and we will contact you as 
soon as possible during regular business hours. 

Other Resources 
Messaging Architects is committed to providing the best support available for GWTreecast. If your question is not 
answered in this guide, our website (www.messagingarchitects.com) includes additional information.  

Corporate Headquarters 
Messaging Architects 
180 Peel, Suite 333 
Montreal, QC Canada H3C 2G7 
Tel: 514-392-9220 
Fax: 514-392-9120 

 

http://www.messagingarchitects.com/GWTreecast
http://www.messagingarchitects.com/support
http://www.messagingarchitects.com/contactus
mailto:info@messagingarchitects.com
http://www.messagingarchitects.com/contactus
http://www.messagingarchitects.com/
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How to Use this Guide 
This guide is intended to complement GWTreecast and introduces concepts in the same order as the layout of 
the GWTreecast Administration Console and associated components. If you are looking for a particular function, 
take a look at the index found at the end of the guide. 

Advice Boxes 
Throughout the guide, you will sometimes see special advice boxes. These advice boxes are intended to 
supplement the information presented in the section where they are found. These advice boxes serve different 
functions based on the icon used to represent them. The three types of advice boxes are: 
 

 More information: This advice box tells you where to find more information pertaining to the current 
subject. Look for this advice box if you want to find out where else in the document a certain subject is being 
discussed. 

 Warning: This advice box lets you know when something requires caution. The goal of this advice box is to 
let you know about the potential errors into which you might run when using the function in question. 

 Helpful tip: This advice box will inform you of advanced configuration tricks. This way, you can optimize 
your configuration and make better use of your GWTreecast components. 

Application and Online Help 
You can access the GWTreecast Installation and Configuration Guide from the application by clicking the Help 
icon in the GWTreecast Administration Console. You can also send support reports (information about questions 
you have that are not covered by this guide) directly to our customer support representatives. 
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1 GWTreecast Overview 

1.1 What Is GWTreecast  
 
GWTreecast is a Shared Folders management solution for GroupWise that integrates with eDirectory. It builds 
Shared Folders trees without end-user intervention. GWTreecast supports broadcasting of entire trees to end 
user accounts, maintaining the folder hierarchy. GWTreecast is also capable of rebuilding the shared folder trees 
in end user accounts in cases of accidental deletion, moving, or renaming of folders. 
 
The Shared Folders are owned by a dedicated GroupWise account. GWTreecast logs into this account and 
through it manages the folder trees and the rights granted to end users. Leveraging the GroupWise Trusted 
Application functionality, GWTreecast also transparently logs into end user GroupWise accounts and accepts, 
arranges, and rebuilds the shared folders it broadcasts. 

1.2 GWTreecast Licensing  
GWTreecast is licensed per GroupWise domain. GWTreecast supports distributed systems without requiring a 
complex licensing mechanism. There may be an unlimited number of GWTreecast installations on a single 
GroupWise system. 
 
Before you can begin using GWTreecast, you must obtain a valid GWTreecast license from Messaging Architects.  
 
To activate your GWTreecast license: 
 
1)  Install GWTreecast. 
2)  Place the malic_signed.xml file in the C\:Program Files/Messaging Architects/GWTreecast directory if you 
installed GWTreecast in its default installation location. 
3) Restart the GWTreecast service.  
 

 Do not attempt to modify the xml file in any way. The license file is digitally signed and will not work if 
tampered with.  
 

 As licensing is bounded to domain names, if the name of your GroupWise domain changes, contact 
Messaging Architects to re-issue the software license. 

1.3 Trusted Application API  
GWTreecast uses the Trusted Application APIs available in GroupWise version 6.5 and higher to perform tasks 
against multiple GroupWise accounts without requiring proxy rights to the accounts. 
 
To run as a Trusted Application, GWTreecast needs a unique key that is created when the program is launched 
for the first time. A Trusted App key can also be recreated later, by choosing Options >Create Trusted 
Application Key from the Main Menu. The Trusted App key is stored in the Primary GroupWise Domain and is 
distributed to all Domains and Post Offices in the system. 
 

 The Trusted Application APIs may raise some security and privacy issues. Note, however, that GWTreecast 
does not expose direct methods to access content in end user accounts.  
 

 For more information on the behavior of the Trusted Application functionality, see 
http://www.novell.com/documentation/gw7/index.html?page=/documentation/gw7/gw7_admin/data/ak8h8gs.html  

© 2007 Messaging Architects 
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2 Installing GWTreecast  
To install GWTreecast, a single executable file must be run on the target workstation. Before launching the setup 
program (SetupGWTC25.exe), make sure that the minimum system requirements are met. 

2.1 System Requirements  
For a successful installation of GWTreecast, ensure that your system meets the recommended system 
requirements as listed below: 
 
 

System Requirements 
 

GWTreecast Server Requirements 
RAM 512 MB  
Novell DirXML 1.1 or higher or Identity Manager 3.0.1 or higher 
ConsoleOne 1.3.5 or higher 
20 MB of free disk space for Program files and additional space for users’ trees database and logs 
Supported Operating Systems 
Windows Server 2003, all versions* 
Windows XP* 
Windows 2000 Professional or Server 
*For Win XP and 2003, a special setup is required if the control MSCOMCTL.OCX is not present. The 
SetupMSCC.zip file is available at http://www.messagingarchitects.com/GWTreecast. To access the file, complete the 
registration fields.  
Supported GroupWise versions** 
GroupWise 7.x 
GroupWise 6.5.x 
** Caching and Remote access modes are not supported 
Client Requirements 
NetWare client, using IP, version 4.83 or above, with latest SP 
GroupWise client 6.5.1 or higher configured to run against GroupWise via IP access 
 

 The DirXML engine is now referred to as the Identity Manager.  

2.2 Important Setup Considerations  
 
To ensure that the GWTreecast installation runs properly: 

 The GroupWise User Interface of the client must be US English. 
 The Format of the Address Book Name Display must be First Name, Last Name. 

 
To ensure the smooth creation of the Trusted Application key during the GWTreecast setup procedure, you need: 

 Proper authentication to the eDirectory tree where the Primary GroupWise Domain resides; 
 Full Admin rights when logging in to the eDirectory tree; 
 Full rights to the target Domains and Post Offices. 

© 2007 Messaging Architects 
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2.3 Running the Setup Program  
For a successful GWTreecast installation and trouble-free operation afterwards, follow the procedure below: 

• Run the GWTreecast SetupGWTC25.exe file.  
• Follow the onscreen instructions. 
• Review and accept the EULA. 
• Choose the destination folder, program group name and if you want to create a shortcut on the 

desktop. 
• Review the settings and wait for the file copy operation to complete. 

 

 

Figure 1: GWTreecast Final Setup Screen 

 

 Before launching GWTreecast for the first time, prepare the Sharer's account and have the GroupWise 
Client logged into this account using the English User Interface. The Address Book Name Display must be First 
Name, Last Name. To integrate GWTreecast with eDirectory, you need the OpenNet Generic Subscriber DirXML 
Driver (see Integrating GWTreecast with eDirectory for more details). 

2.3.1 Upgrading from Previous Versions of GWTreecast  
By default GWTreecast 2.5.1 installs in folder C:\Program Files\Messaging Architects\GWTreecast\. This is 
different from previous installations. 
 
If you are upgrading GWTreecast from a previous version, before you launch the program for the first time, 
perform the following manual changes: 

1. Back up your previous Treecast program folder.  
2. Make a separate copy of the \Trees subfolder; this is the Shared Folders database. 
3. Copy the contents of the old \Trees subfolder to the new GWTreecast installation \Trees subfolder. 
4. Copy the contents of the old \Config subfolder to the new GWTreecast installation \Config subfolder. 

 

 You’ll be prompted to perform the above procedure if GWTreecast detects a previous version installed on 
the same machine. 

© 2007 Messaging Architects 
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After you complete the GWTreecast upgrade, start GWTreecast: 
• Let the program check the Folders IDs. 
• Let the program upgrade Folder IDs. 
• If errors occur during the check, confirm the fixes. 
• Save the last log file as it contains important information on the upgrade. The log file is found in the 

\Logs subfolder. 

 GWTreecast 2.5.1 uses a new licensing mechanism and requires a new license. To obtain a new license for 
GWTreecast 2.5.1, contact Messaging Architects at logistics@messagingarchitects.com. 

2.3.2 Migrating Registry Settings to Config.xml  
GWTreecast 2.5.1 keeps its settings in an XML file found in C:\Program Files\Messaging 
Architects\GWTreecast\Config\Config.xml. If there is a previous installation of GWTreecast on the workstation, the 
settings will be migrated automatically from the Registry to the XML file. You will be notified if this process fails. 

2.3.3 Installing GWTreecast on a New Workstation  
If you are already using GWTreecast in your organization and want to install the new version on a different 
workstation, perform the following procedure before the first launch of the program: 

1. Using Regedit.exe export the following registry key from your previous installation: 
HKEY_CURRENT_USER\Software\VB and VBA Program Settings\OpenNet Generic Subscriber 
DirXML Driver-TreeCastServer 

2. Import the key onto the new workstation. 
3. Copy the content of the old \Trees subfolder to the new GWTreecast installation \Trees subfolder. 
4. Copy the content of the old \Config subfolder to the new GWTreecast installation \Config subfolder. 

2.4 Uninstalling GWTreecast  
To uninstall GWTreecast, choose Control Panel > Add or Remove Programs and select Add or Remove 
Programs to open the currently installed program list on Windows. Select GWTreecast from the list and click 
Remove. The Windows uninstaller will remove GWTreecast from your system. 

2.5 Defining GWTreecast as a Trusted Application  
GWTreecast v2.5.1 runs as a Trusted Application with GroupWise 6.5.1 and above. When running as a Trusted 
Application, GWTreecast is able to access end user mailboxes without proxy rights to their accounts. A special, 
system-unique key, called a Trusted App Key, must be created to define GWTreecast as a Trusted Application.  

2.5.1 Defining a Trusted Application Key  
The first time you run GWTreecast, you will be prompted to create a new Trusted Application object to define 
GWTreecast as a Trusted Application. When prompted, click Yes. You will be notified when the key is created 
successfully. It will take a minute to distribute the key to the GroupWise system. 
 
The successfully created Trusted Application key is encrypted and stored in the Config.xml file located in 
C:\Program Files\Messaging Architects\GWTreecast\Config. 
 

© 2007 Messaging Architects 
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Figure 2: Trusted Application Key Creation 

 

 For the Trusted App Key procedure to complete successfully, you must close the GroupWise Client, Address 
Book, and Notify. 
 

 Optionally, you may click No in the message box if you wish to import another Trusted Application key. For 
example, if you are already using GWArchive, which also runs as a Trusted Application, you may use that key 
with GWTreecast. 

2.5.2 Defining a Trusted Application Key for Multiple GWTreecast 
Servers  

The option to import an existing Trusted Application Key is useful when you have more than one installation of 
GWTreecast. In that case, create a Trusted App key for the first installation, and then import that key for any 
other installations.  
 
To import a Trusted App Key: 

• From the GWTreecast Options menu choose Show Trusted App Key. 
• Copy the key to the clipboard and paste into a text file. 
• On the second GWTreecast installation, click Create Trusted App Key and answer No when 

prompted to create new key. 
• Enter GWTreecast as the application name and paste the previously created key. 

© 2007 Messaging Architects 
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2.6 Configuring GWTreecast  
When you first launch GWTreecast, the Settings window opens automatically. The fields highlighted in red below 
are obligatory and need to be filled in. 
 
GWTreecast Administrators 
The GWTreecast Administrators are users that will be notified via email on GWTreecast events and errors if the 
Send Admin Messages box is selected. Use the Add button to add the users to the list. 
 
Refresh Delay 
This setting is needed for some operations to be completed by the GroupWise Post Office Agents. Adjust it to 
your particular GroupWise system. The default setting is 3 seconds; if you experience failures, increase the 
value. 
 
Write Logs 
Select this option if you want logs to be written by GWTreecast. As a best practice, Messaging Architects 
recommends enabling the Write Logs option. 
 
Debug Level 
This option is used for troubleshooting and should be enabled if requested by Messaging Architects’ Support 
Team in the event of problems. 
 
Process Events and Tasks 
Select this option to enable processing of scheduled tasks and DirXML events. 
 
Lock the GUI at startup  
Select this option to disable all user controls for security reasons.  
 
Shared Trees Owner Account ID 
All the Shared Folders are owned by a dedicated GroupWise account (the Sharer’s account) to which 
GWTreecast logs to manage the Shared Folders trees and the end user rights. The credentials for this account 
need to be entered in the GWTreecast Admin Console. 

• Shared Trees Owner Account ID: Enter the GroupWise account that owns the Shared Folders.  
• Password: Enter the GroupWise password for the Sharer’s account  

 
Path to Primary Domain 
Browse to select the location of your primary GroupWise domain – this is the Path to primary domain. 
 
User Settings 
Select the option Send Welcome Mail to send a Welcome message to users when trees are automatically 
distributed to them based on eDirectory events. 
Select the option Remove Trees to instruct GWTreecast to revoke folder sharing rights when users are removed 
from groups to which Shared Trees are assigned (see Integrating GWTreecast with eDirectory for details). 
 
PO Addresses 
Expand the Domains listed in PO Addresses. Right-click each Post Office to set the IP address and port of the 
respective Post Office Agent. 
 
Enable LDAP 
Select Enable LDAP to enable eDirectory integration. Fill in the fields with the necessary information. For more 
details on LDAP Settings and the association between Shared Folders trees and eDirectory groups, see 
eDirectory Integration Configuration. 
 

© 2007 Messaging Architects 
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Figure 3: GWTreecast Settings Screen 

2.7 Integrating GWTreecast with eDirectory  
The GWTreecast integration with eDirectory allows NDS group membership to determine and trigger automatic 
provisioning of the group’s assigned Shared Folder tree to new members. To accomplish this Novell DirXML or 
Identity Manager 3.0.1 or higher must be installed in the eDirectory tree.  
 

 GWTreecast requires LDAP Access to eDirectory (see Basic LDAP Configuration). 
 
When a user is added or removed from an eDirectory Group, this triggers an event in eDirectory. This event is 
exported by the OpenNet Generic Subscriber DirXML Driver to an XML file. GWTreecast checks the output folder 
of the driver and when an event file is found, it processes it as follows:  

• When a user is added to a group, GWTreecast checks if there are Shared Folders trees assigned to the 
group and distributes the folders to the user.  

• When a user is removed from a group, GWTreecast, if configured so, revokes the rights to all Shared 
Folders trees associated to that group. 

 
Since GWTreecast works as Trusted Application it accesses all GroupWise accounts without special proxy rights. 
However, the users must be already members of GroupWise Post Office. 
 

 Only newly added or removed users are processed. 

© 2007 Messaging Architects 
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2.7.1 Basic LDAP Configuration  
To configure the LDAP settings (bottom left-hand panel of the GWTreecast Admin Console) go to Options > 
Settings on the GWTreecast menu. 
 

 

Figure 4: LDAP Settings 

 
• Select Enable LDAP.  
• Enter the full DN of the eDirectory administrator and the administrator’s password. In this version, the 

LDAP server does not require SSL and allows clear text password. 
• Enter the LDAP Server DNS name or the IP address and the port. 
• Click Apply to apply the setting changes and then reopen the LDAP Settings window. 
• Click Test the connectivity to eDirectory. 
• Under Event Files Folder, enter the path to the folder where GWTreecast’s OpenNet Generic Subscriber 

DirXML Driver will export NDS Events. The same path must be configured in ConsoleOne for the 
OpenNet Generic Subscriber DirXML Driver.  

 The option Process Events and Tasks in the GWTreecast Admin Console must be enabled for 
eDirectory Integration. It may be also temporary enabled/disabled from the main screen. 
 
• Enable Send Welcome Mail in the User Settings frame to send an email message to users when 

new trees are broadcast to them. Click the button to enter Subject and Text  
• Enable Remove Trees when users are removed from groups to revoke trees associated with an 

eDirectory group when a user’s membership in that group is canceled. Otherwise the Shared Folders 
trees will be left in the user's mailbox after his/her removal from the group. 

2.7.2 eDirectory Integration Configuration  
To allow GWTreecast to respond to relevant events occurring in eDirectory, you need to install and configure the 
OpenNet Generic Subscriber DirXML Driver. You also must already have LDAP configured and tested.  
 
Before you start the integration process, save at least one tree as it will be required later to be assigned to a 
group object in eDirectory. 
 

© 2007 Messaging Architects 
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From the GWTreecast main menu choose Settings and click Map LDAP Object to trees to open the Directory 
Services Integration Settings dialog box.  
 

 

Figure 5: GWTreecast eDirectory Integration Settings 

This window has two areas: 
• A list of all saved trees with the names they were given when saved. Messaging Architects 

recommends using grou names as a best practice. 
• eDirectory trees – the view filters for Group objects. 

 
Assigning Saved Trees to eDirectory Groups  

• Select the saved trees in the list on the left. 
• In the right window, select the group(s) to which you want to add trees. 
• Click Assign to add a saved GWTreecast tree to the selected group object(s). 
• Click Save to save the changes made on this screen. 

 
Removing (Unassigning) Saved Trees from eDirectory Groups  

• In the right window, highlight the Assigned tree(s) you wish to remove from the group object. 
• Click the Remove button. 
• Click Save to save the changes made on this screen. 

 

 GWTreecast must be restarted after changing the configuration. 
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2.7.3 Installing the OpenNet Generic Subscriber DirXML Driver  
To install the OpenNet Generic Subscriber DirXML Driver, follow the procedure below: 
 
1. Install Novell DirXML 1.1 or higher or the Identity Manager 3.0.1 or higher on your server. If you only intend to 
use DirXML for the OpenNet Generic Subscriber DirXML Driver, disregard installation of preconfigured drivers as 
you only need the engine components. You will need a license from Novell for the DirXML engine. The default 
evaluation period is 90 days. You may use the OpenNet Generic Subscriber DirXML Driver with an evaluation 
version of the Novell DirXML engine. The engine license can be installed later without requiring reinstallation of 
the driver. 
 

 The DirXML engine is now referred to as the Identity Manager.  
 
2. Install Java SDK or JRE version 1.4.x; to download the latest version, go to http://www.sun.com/java/. On 
Windows servers, make sure that the JAVA_HOME and CLASSPATH environment variables are defined and refer 
to the correct path. 
 
3. The GWTreecast Setup Program will install the Generic Subscriber DirXML Driver in the GWTreecast 
installation directory – C:\Program Files\Messaging Architects\GWTreecast\DirXML\ – and in the two sub-
directories: \jar\ and \xml\.  
 
4. Copy the ONGenSubscriberDriverShim.jar file from C:\Program Files\Messaging 
Architects\GWTreecast\DirXML\jar\ to: 

• On NetWare: SYS:System\Lib  
• On Windows: [NDS Installation]\Lib (Typically, this is C:\Novell\Nds\Lib)  
• On Linux/Unix: [NDS Installation]/Lib 

 
5. Start ConsoleOne. If you have an older version of DirXML, you can use the DirXML snap-ins. If you don’t have 
DirXML, download Identity Manager 3.0.1, and then use the DirXML snap-ins.  
 
6. Run the Create a New Application Driver option from the ConsoleOne Wizard menu. 
 
7. Select an existing Driver Set or create a new one. Choose to create a partition on the Driver Set (Novell’s 
recommendation) and click Next. 
 
8. Select Import pre-configured driver. 
 
9. Browse to the ONGenSubscriber.xml file in C\:Program Files\Messaging Architects\GWTreecast\DirXML\xml\ 
folder.  
 

 

Figure 6: Application Driver Creation 

© 2007 Messaging Architects 
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10. Enter a name for the driver, and then click Next. 
 

 

Figure 7: Application Driver Naming 

11. Define the Security Equivalences for the driver, i.e., what rights the driver will have in the directory. Since 
the driver only receives events from eDirectory, any user with Read rights to the relevant containers may be 
used.  
 
12. Define the Administrative Roles, i.e., the users and other objects, such as Admin, to be excluded from 
replication by the driver and click Finish. 
 
13. The Driver Object and the Subscriber beneath it are created in eDirectory. 
 

 

Figure 8: OpenNet Generic Subscriber DirXML Driver and Subscriber in eDirectory 
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2.7.4 Configuring the OpenNet Generic Subscriber DirXML Driver  
 
1. In ConsoleOne, right-click the Driver Set object and select Properties. 
 
2. On the DirXML tab, select Drivers. If you have more than one server, select the location where the OpenNet 
Generic Subscriber DirXML Driver is installed. 
 

 

Figure 9: Configuring the OpenNet Generic Subscriber DirXML Driver  

 
3. Select the driver from the list, and then click Properties. 
 

 

Figure 10: OpenNet Generic Subscriber DirXML Driver Properties 

 
4. Choose the Driver Parameters tab. Specify an output folder for the DirXML event files. The driver will create 
a \Logs subfolder in the selected path. Click OK to close the window. 
 
5. Next configure the Subscriber filter to define the types of objects and attribute changes monitored. You may 
add as many object classes as you wish; be careful as adding too many attributes to the filter will generate a lot 
of events. 
 
6. Right-click the Subscriber object and click Properties. 
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Figure 11: OpenNet Generic Subscriber DirXML Driver and Subscriber in eDirectory 

7. Click Edit Filter. A new dialog box appears that allows you to select the type of objects and the attributes to 
monitor. First click and select the Group class on the left, then select the attributes for the selected class on the 
right. At a minimum, make sure that CN and Member are selected. In addition, you can filter Create events by 
changing the Creation Rule found under the Subscriber object. 
 

 

Figure 12: Configuring the subscriber filter 

 
8. Start the OpenNet Generic Subscriber XML Driver by right-clicking the OpenNet object in eDirectory. Right-
click the Driver Set object and select Properties. From the DirXML tab, select Drivers. If you have more then 
one server, select the server the driver is installed on. Highlight the OpenNet Generic Subscriber XML Driver in 
the list and press Start. The driver state should change to Running. 
 
9. Check the output folder that you defined in step 4. If the driver is working, a new log file will be created in the 
Logs subdirectory.  
 
10. Set the startup type of the driver to automatic, so it is loaded when eDirectory starts on the server. 
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3 Running GWTreecast   

3.1 GWTreecast Admin Console  
The following options are available in the GWTreecast Admin Console.  
 

 

Figure 13: GWTreecast Admin Console 

 
Choose File to perform the following tasks:  

• Show Log: Opens the current log in Notepad. 
• Delete Log: Deletes the current log. 
• Create Scheduled Task: Opens a window for creation of scheduling tasks. 
• Manage Scheduled Tasks: Opens a window where you manage scheduled tasks. 
• Quit: Exits GWTreecast. Disabled during processing. 

 
Choose Options to perform the following tasks: 

• Debug Logging: Enables debug logging during the current run of GWTreecast. The option can be set 
as default in Settings. 

• Lock Console: Locks the console; the Sharer’s GroupWise password is required to unlock it. 
• Settings: Opens the Settings dialog box. 
• Create Trusted App Key: Creates a Trusted Application Key to configure GWTreecast as a Trusted 

Application. 
• Show Trusted App Key: Shows the decrypted Trusted Application Key. 
 

Choose Help to perform the following tasks: 
• User Guide: Launches the Help file. 
• About: Gives information about the GroupWise APIs, GWTreecast version, and system information. 
• Create Configuration Report: Creates a report on the settings and installation environment which is  

useful for troubleshooting. 
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Folders Tree  

• Shared Folders appear with the GroupWise icon for shared folder and their names in red. 
• Refresh refreshes the folders list from GroupWise. 
• Expand All opens the entire folders tree – in large trees this can be a time-consuming.  
• Collapse reduces the display to the first level under Cabinet. 
• Check the Cabinet to select all subfolders. 
• Expand a folder to see its subfolders. If the folder is checked, all child folders will be checked too.  
• Right-click a folder and select Expand Branch to expand only its children. 
• Enable/Disable Events and Tasks Processing temporarily enables/disables processing of scheduled 

tasks and DirXML events. 
• Use Save Tree Selection to save a subset of selected folders. 
• Use Load Saved Tree to load a subset of selected folders. To delete a saved tree, highlight it and right 

click to enable its deletion. 

 The last two options are useful when you work with constant sets of folders for assigning trees to eDirectory 
groups or for use of trees in scheduled tasks. 
 
Folder Actions Pop-up Menu  
When you right-click a folder, a drop-down menu with the following options appears: 
 

 

Figure 14: Folder actions pop-up menu 

• New Folder: Creates a new subfolder under the selected folder.  
• Rename Folder: Renames the selected folder.  
• Delete Folder: Deletes the selected folder. GWTreecast will delete only empty, unshared folders. 

 You cannot delete a shared folder or a folder with subfolders directly. To delete a shared folder, remove 
sharing rights from the folder you wish to delete and delete all subfolders. This ensures that tree integrity is 
maintained and minimizes possible errors.  

© 2007 Messaging Architects 



GWTreecast Installation & Configuration Guide 23 

• More: Opens a sub menu with the following options:  

 Find Folder by Name: Finds one or more folders with a given name in the entire folders tree.  
 Select Folders by Name: Selects all folders with a given name. 
 Select Folders by User: Selects all folders shared with a given user. 
 Mass Rename of Folders: Renames all folders with a given name to a new one. 
 Mass Delete of Folders: Deletes all folders with a given name in the entire tree. 

• Create Subfolders From File: Enables creation of single-level folders, with names read from a text 
file. Folders are assigned unique GWTreecast ID during this process. 

• Save Subtree: Saves the names of the selected folders to a file  
• Load and Create Saved Subtree: Creates a subtree from the option above under the currently 

selected folder. This is similar to a Copy & Paste operation. 
• Expand Branch: Recursively expands each level of subfolders until the entire branch is displayed. 
• Collapse Branch: Closes the expanded subfolders. 
• View History: Opens a dialog box displaying a log of all actions performed by GWTreecast on the 

selected folder (such as sharing, revocation or modification of rights). 
 

 

Figure 15: Viewing folder’s history 

 Currently, GWTreecast does not support moving folders in the tree. To move existing folders, open the 
Sharer’s account in the GroupWise Client and perform the desired changes there. 
 
New Shares  

• Add Users: Opens the GroupWise Address Book to let you select users to share folders with. 
• Remove from list: Removes selected users or distribution lists from the new shares. 
• User(s) Rights: Select the appropriate options to set the desired rights. 
• Send Messages to new users: Select the option and type a message to be sent to new users after 

folders’ broadcast. The <name> string will be replaced with the shared folder name. 
• Apply: Click to start folder sharing for the users in the list.  

 
Current Shares  

• Highlight a folder to display the list of users that have rights to it. 
• If more than one folder is selected, only the shares of the last folder are displayed. Use the Select 

Users button to add other users. Revoke All Rights removes the sharing rights from the selected 
users in the Current Shares list. 

• User(s) rights checkboxes show the rights the selected user has on the selected folder(s). Changing 
the marks in the boxes enables modifying rights. Click Apply after making changes to user rights for 
the changes to take effect.  

• Click Rebuild User(s) to check or fix problems with Shared Folders in the selected users’ accounts.  
• Select All selects all users in the Current Shares list. 
• Clear All resets the list. Click the folder again to see list of shares.  
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Status Bar  
• Displays the currently selected folder and its GWTreecast ID. 
• Shows the number of subfolders under the currently selected folder. 
• Shows the action that GWTreecast currently performs. 

 
Double-click the status bar to see the current actions as written to the log. Double-click the bar again to return 
to normal display. 
 

 

Figure 16: GWTreecast Main GUI – current actions display 
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4 GWTreecast Functionality  

4.1 Folder Sharing  
When one or more folders are shared to end users using GWTreecast, the following occurs: 

• Selected rights are given to each user in the New Shares list for each selected folder.  
• Changes are committed to the GroupWise Post Office and a Shared Folder Notification Message is sent 

to the end user account. 
• Messages sent by GWTreecast have GWTreecast Reshare Requests or New GWTreecast Share as 

the subject line. End users cannot open and accept these messages.  
• GWTreecast accepts all GWTreecast Sharing messages in end users accounts. Folders are temporarily 

placed under a special folder, created by GWTreecast under the users’ cabinet named GWTreecast 
System Folder.  

 

 

Figure 17: GroupWise view: folders placed in the GWTreecast System Folder 

 
• GWTreecast arranges all accepted folders in the correct structure.  
• If there are missing folders in the shared tree, GWTreecast creates private “Place Holder” folders.  

 

 

Figure 18: GroupWise view: Place Holder Folder, Company Docs(TC) 
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4.2 GWTreecast Placeholder Folders  
It is common practice for some folders to be shared with a given user and others not. Nonetheless, the structure 
of the shared folder tree or subtree is important (such as when the root of the sub-tree is a department or a 
client name) in that it provides the context of the folder. GroupWise does not currently provide the folder context; 
only the folders that are shared with users are sent to them without the relevant context. 
 
GWTreecast solves this problem by building the exact shared folder tree structure that was defined in the 
Sharer’s account, including the correct folder names. GWTreecast creates placeholders, i.e., personal folders in 
place of folders that were not shared with the user and adds a (TC) suffix to indicate their special status as place 
holders. 
 
Example 
Here is a typical scenario that shows the Sharer’s folder tree and the end-user’s folder tree, composed of 
Shared and Placeholder folders. The views in the GroupWise clients are shown and vary depending on the 
viewing rights of the end user in each case. 
 
Case A 
     GWTreecast Sharer View                                GWTreecast End-User View            

 
 
Case B 

 

 

Figure 19: Place Holder folders 

In the GWTreecast Sharer view, we see the complete folder structure, even if the folders are not shared with the 
end user (such as TechSupport, Incidents and Tools). Folders and subfolders that are not shared with the 
GWTreecast end user are not created in the end user’s GroupWise account (such as Incidents), except where 
necessary for structural context (such as TechSupport and Tools). 
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To help the user understand the context of a shared folder placed under an unshared one (such as VNC), 
GWTreecast creates Placeholder folders, such as TechSupport(TC) and Tools(TC). These folders are personal 
folders in the user’s account and have no connection to the original folders in the Sharer’s account except their 
names (See Fig.18, Case A). 
 
If a user stores email, documents or other messages in a Placeholder folder (such as Tools), and the original 
folder with the same name is shared with the user, GWTreecast will move the Placeholder folder to the 
GWTreecast System folder retaining the saved messages and documents (See Fig. 18, Case B). 
 

4.3 Folders Verification  
When GWTreecast verifies end-user folders, it performs the following: 

• Checks if the folders are in the expected place. 
• Checks for unaccepted GWTreecast Sharing messages. 
• Checks for moved or renamed folders. GWTreecast maintains a special XML database for each user in 

order to find corrupted (renamed) folders. If the folder is not found, it is revoked from the user in order 
to prepare it for re-sharing.  

• After all folders are checked and if there were missing folders for one or more users, GWTreecast shuts 
down and launches another program, TCReShare.exe, which re-shares the missing folders to end 
users. GWTreecast launches automatically when re-sharing is completed.  

• GWTreecast accepts all new shares for the end users and arranges the folders in the correct structure. 
• Messages are sent to admin users notifying them that re-shares are processed. 

 

4.4 Modifying / Removing Users’ Rights on Folders  
When GWTreecast modifies or removes end user rights to existing shared folders, it performs the following: 

• When rights are modified, GWTreecast sends a notification message to the affected end users and 
updates the users’ XML database. 

• When rights are removed, GWTreecast revokes rights in the correct order. 
• If a folder is removed without removing its subfolders, GWTreecast creates a private Placeholder folder 

in the end user’s account to maintain the tree structure.  
• GWTreecast checks that the folders are really removed from the end user. The XML user database is 

updated with the new status of the user. 
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5 Using GWTreecast  

5.1 Sharing Folders and Trees  
Sharing a folder with GWTreecast 
To share a folder with GWTreecast, select each folder you want to share in the Tree Folder view of the 
GWTreecast Admin Console. If no folder is selected but is highlighted, it will be shared. If you want to share the 
entire tree or subtree, collapse it to the level you wish to share from and then select it. All subfolders are 
automatically selected for sharing. 
 
To share “discontinuous” folders from different levels and trees, just check the desired folders. Unselected 
folders with selected subfolders will be created as private Placeholder folders in the target users’ accounts to 
maintain the correct folder structure. 
 

 

Figure 20: Sharing a tree 

Selecting users to assign sharing rights 
Select Groups or Users by clicking Add Users and selecting the desired entries from the GroupWise Address 
Book. 
 
Assigning Folder Access Rights to User(s) 
Select one or more users (CTRL+click) and define the desired access rights for that/those user(s) by selecting 
Add, Modify, or Delete. 
 
Applying Shares to Folders 
When you click Apply, GWTreecast will broadcast the assigned access rights for each of the selected folders to 
each of the defined users. GWTreecast accepts the shares on behalf of the respective users employing the 
GroupWise proxy capabilities and building the Shared Folders tree in each account transparently.  
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5.2 Rebuilding Users’ Trees  
GWTreecast can rebuild the entire Shared Folders tree for a given user if they have been accidentally erased, 
moved, or renamed. To do this, follow the steps below: 

• Define the scope of the Rebuild operation: Entire Tree, Branch (subtree), or single folder.  
• Select the entire Tree by selecting the Cabinet, a branch or sub-tree by selecting it when collapsed, or 

a folder by selecting or highlighting it. 
• Select User(s): From the list of users in the Current Shares pane or by clicking Select Users. 
• Click Rebuild User(s): GWTreecast Server will traverse the selected trees and rebuild the correct 

Shared Folders tree for the selected users.  

5.3 Modifying Rights to Shared Folders  
To modify rights to a folder already shared with one or more users:  

• Select the folder in question in the tree view on the left. To modify rights for an entire subtree, select 
the folder when collapsed which will select all subfolders. 

• Highlight the folder and all users it is shared with will appear in the Current Shares pane. You may 
also manually add users selecting them from the GroupWise Address Book and clicking Select Users. 

• Set the new rights by selecting the desired boxes (Add, Modify, or Delete) and click Apply. 

5.4 Revoking Rights to Shared Folders  
To revoke rights to a folder already shared with one or more users:  

• Select the folder in question in the tree view on the left. To remove an entire subtree, check the folder 
when collapsed which will select all subfolders. 

• Highlight the folder and all users it is shared with will appear in the Current Shares pane. You may 
also manually add users for removal by selecting them from the GroupWise Address Book and clicking 
Select Users. 

• Click Revoke All Rights and then Apply. 

5.5 Revoking All Shared Folders from a User  
In some cases, for example when a user leaves the organization, you may need to remove all folders shared with 
the user. To do this: 

• Right-click a folder and from the drop-down menu select More... >Select Folders by User.  
• Select the user from the pop-up Address Book and click OK.  
• GWTreecast will automatically select all folders shared with this user. 
• From the bottom right frame click Select Users and choose the target user. 
• Click Revoke All Rights and then Apply. 
• GWTreecast will revoke all rights and delete the folders from the target account. 
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5.6 Defining and Saving Shared Folder Trees  
It is common in an enterprise to share different sets of folders with different groups, such as Sales, Support, 
Management, etc. GWTreecast enables defining and saving such sets (Trees) and easily distributing them to 
every new user joining a particular group.  
 
Saving trees is also used for the creation of tasks which can be scheduled to run in a convenient time (see Task 
Scheduling). 
 
Define the tree you would like to save and select the folders to be part of this tree from anywhere in the entire 
tree, regardless of branch or level. Click Save Tree Selection, enter a name for the tree, set the access rights 
for each folder in the tree, and click Save. 
 
To delete a saved tree, click Load Saved Tree, select a tree from the list of trees, and right-click the desired 
tree to enable its deletion. 
 
To load a tree, select its folders in the left panel, click Load Save Tree, select the desired tree, and click OK. 
Once the folders are selected you may use the selection for sharing, modifying, removing, or rebuilding.  

 

Figure 21: Saving a Tree 
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5.7 Task Scheduling  
GWTreecast v2.5.1 enables users to create tasks and schedule them to run at a convenient time. To create a 
task and manage already created tasks, use the two submenus under the File menu. 
 

 

Figure 22: Task Scheduling 

5.7.1 Creating a Scheduled Task  
You can create 3 types of scheduled tasks with GWTreecast:  

• sharing folders; 
• rebuilding shared folders; 
• removing users’ rights from folders.  

 For a scheduled task the folders which will be shared, rebuilt or unshared should be preliminarily defined 
and saved as trees (see Defining and Saving Shared Folder Trees).  
 
From the Main Menu, choose File > Create Scheduled Task (Ctrl+T). From the left-hand pane, select the 
trees which will be shared, rebuilt, or removed and define the type of action in the Task Type field. Add users 
from the right-hand upper pane. Choose if the task will be recurring or will be performed only once and define 
the start time. Select the start date in the calendar. Click Save and give the task a relevant name. 
 

 

Figure 23: Create Scheduled Task 
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5.7.2 Managing Scheduled Tasks  
To view and manage scheduled tasks click File > Manage Scheduled Tasks.  
 
The tasks are displayed in a window showing the time they are scheduled to run and the type of action that will 
be performed, as well as a recurring tasks’ last run time. The tasks scheduled for single run are automatically 
deleted after execution. 
 

 

Figure 24: Managing Scheduled Tasks 

A task’s current status is shown in the Enabled column. To see the trees and target users of a task, double-click 
it. To delete a task, select it and click Delete. To disable/enable a task, select it and click Toggle Enabled.  
 

 GWTreecast must be running in order to perform scheduled tasks. 
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6 Troubleshooting GWTreecast  
 
Logging 
In case of any persistent problems, run GWTreecast Server and check Enable Logging in the Settings window. 
The log files are necessary for solving issues when contacting technical support at Messaging Architects is 
needed. It is recommended to enable logging even during normal use.  
 
Debug level logging 
Set the option to output debug information in the log, if instructed so by support. Do not leave this option on in 
standard operation mode. 
 
Refresh Delay 
This defines how long GWTreecast will wait for target client’s account to refresh. GroupWise uses multithreading 
and queues, thus messages and events are not processed sequentially. This is why the delay is necessary for 
operations such as broadcasting new folders or rebuilding deleted trees. A good value to start with is 3 seconds. 
If you experience problems such as unaccepted new shares, or folders remaining in the target client after 
removal, increase the value. For a slow or heavily loaded Post Office, a value of 10 to 15 seconds is 
recommended. 
 
The Trees Database  
GWTreecast keeps important data about the shared trees structure in the /Trees subdirectory. Do not alter its 
content in any way. If this occurs, you will need to rebuild the whole database, which may be time consuming.  
 
Trusted Application Login 
To set GWTreecast to work as Trusted Application, you need a Trusted Application key present in the Config.xml 
file. If you have to re-create the key, click File > Options > Create Trusted App Key to create it. 
 
Cached / Remote GW modes  
These are not supported for GWTreecast, make sure that the GroupWise client is configured to log in in direct 
mode, via IP connection to the POA. 
 
Rebuilding the GWTreecast Shared Trees Database: 

a) Delete or move the \Trees subdirectory, found under the GWTreecast program directory. 
b) Create two empty files, named Upgrade.txt and Check.txt under the GWTreecast installation 

directory. 
c) Restart GWTreecast. 
d) When prompted, accept the upgrading of all IDs from the previous version. 
e) Wait for the process to complete. 
f) Restart GWTreecast. 
g) Check the Cabinet to select all subtrees. 
h) In the Current Shares list, select all users using GWTreecast trees. 
i) Choose Select All users in the list. 
j) Perform Rebuild on the selected users. 
k) Wait for the process to complete 
l) After the process is complete, verify that XML files were created under the \Trees sub-directory 
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Common Problems and Solutions:  
 
Problem Possible Cause Fix 

No valid license. Obtain a valid license. If you have purchased a 
license, ensure the malic_signed.xml  file is 
in the installation directory. 

No connection to the Sharer 
account’s PO. 

Log into the Sharer account from GroupWise. 
If you can’t, resolve the issue and retry. 

GWTreecast installation directory is 
read-only. 

Give full access to the GWTreecast Windows 
account, the installation directory, and 
subdirectories. 

Settings can’t be read from the 
Windows registry. 

Check Registry permissions. Rerun 
GWTreecast setup, installing it in the same 
directory to preserve the GWTreecast 
database. 

Another instance of GWTreecast is 
running. 

Check the log file for errors. Check Windows 
Task Manager for a running instance of 
TCServer.exe. 

GWTreecast fails to 
launch before 
GroupWise login 

Disk is full. Free up disk space. 
Incorrect Username/ Password 
credentials. 

Specify the correct credentials in the Settings 
window. 

GroupWise/Notify are logged into 
another account. 

Close all GroupWise components that hold a 
connection to another GroupWise account. 

GroupWise login information cache 
is incorrect. 

Delete the Registry values under: 
HKEY_CURRENT_USER\Software\Novell\Gro
upWise\Login Parameters 

Network problems- no IP connection 
to the GroupWise PO. 

Check network settings and configuration. 

Incorrect GroupWise Address Book 
format. 

Set the GroupWise Address Book display 
format to First Name, Last Name. 

GroupWise 
connectivity problems 

Log file can’t be created. Check disk space and rights to the \Logs 
subdirectory. 

No Folder Tree is 
displayed. 

Trees Database was modified 
manually or XML files are corrupt. 

Restore the \Trees subdirectory or perform a 
complete rebuild of the GWTreecast database. 

Selecting a folder also 
selects additional 
folders. 

The view is out of date. Click Refresh in the GWTreecast Admin 
Console 

Folders are sorted 
incorrectly.  

Folders remain under 
the GWTreecast 
System Folder. 
Rights to folders are 
not removed. 
Looping when 
restoring shared 
folders occurs. 

Refresh Delay time setting is too 
short. 

Increase Delay Time in GWTreecast Admin 
Console. 

Status Bar displays 
“Cannot login to 
user’s account” 

Failed Trusted Application login. Check or recreate the Trusted App Key. Check 
the settings for the Sharer’s account name 
and password. 

Folders are shared 
with incorrect rights. 

No rights were granted during the 
sharing. 

Users/Groups need to be selected in the 
New/Current Shares User List before 
granting user rights to folders. 

Rights modification 
doesn’t work 
correctly. 

Required changes weren’t saved. Click Apply to apply the modifications. 

Only root folders are 
processed. 

The root folder was checked while 
the sub-tree was expanded or the 
collapsed folder was highlighted 
without being checked. 

For operations on an entire sub-tree, ensure 
the sub-tree is collapsed and check the root 
folder’s checkbox. 

Administrators do not 
receive notifications 

Admin notification isn’t enabled. Check the Enable Admin Messages option in 
the GWTreecast Admin Console. 

Unexpected errors Trying to access Sharer account in 
Proxy mode. 

Shut down the GroupWise Client, and restart 
GWTreecast Server. 
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